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1.  Introduction 

     1.1  Purpose             

The purpose of the document is to collect and analyze all assorted ideas that have come 

up to define the system, its requirements with respect to consumers. Also, we shall 

predict and sort out how we hope this product will be used in order to gain a better 

understanding of the project, outline concepts that may be developed later, and 

document ideas that are being considered, but may be discarded as the product 

develops. 

In short, the purpose of this SRS document is to provide a detailed overview of our 

software product, its parameters and goals. This document describes the project's target 

audience and its user interface, hardware and software requirements. It defines how our 

client, team and audience see the product and its functionality. Nonetheless, it helps any 

designer and developer to assist in software delivery lifecycle (SDLC) processes.  

     1.2  Scope 

           SalesGrow CRM helps organizations differentiate their businesses to achieve 
maximum top-and bottom-line growth. WTM offers the broadest and deepest portfolio 
of CRM solutions that address all customer touch-points and provide rich functionality to 
support the specific business needs for organizations of every size to deliver a superior 
customer experience. 
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     1.3  Overview 

The remaining sections of this document provide a general description, including         

characteristics of the users of this project, the product's hardware, and the    

functional and data requirements of the product.  

General description of the project is discussed in section of this document.  It  gives the 

functional requirements, data requirements and constraints and assumptions made 

while designing the SalesGrow.  It also gives the user viewpoint of product.  It also gives 

the specific requirements of the product.  It also discusses the external interface 

requirements and gives detailed description of functional requirements. It is for 

supporting information. 

 

2.  Specific Requirements 

     2.1 Functionality 

The functional requirements of the SalesGrow CRM service can be grouped into tree main parts:  

2.1.1 Front End 

 

 

2.1.1.1 Modules 

 

3.2.7.1.1 Home:  The Home tab in SalesGrow CRM gives you the option to add components 

(widgets) that are most often used. For example, you can add a component to view 

the tasks and events for today or the list of potentials that are closing this week. 

Also, you have the option to add components from dashboards that represent pie 

charts, funnel diagrams and bar charts.  

3.2.7.1.2 Dashboard: Dashboard is a pictorial representation of your custom reports, which 

gives a real-time snapshot of your organization's key metrics. Using dashboards, you 

can easily visualize the patterns and trends in sales, marketing, support, and 

inventory related data. For example, you can glance at the products that are selling 

fast over a period of time, compare the current quarter sales with previous quarter 

sales, or compare the actual sales to the projected sales. 
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3.2.7.1.3 Lead: WTM SalesGrow CRM gives you the opportunity to optimize your lead 
generation process by creating genuine leads that have higher conversion 
Probability. By automating tasks, managing & categorizing contacts (as per location, 
industry or source) and sending out regular product information to existing and 
prospective customers, WTM SalesGrow makes the lead generation procedure 
highly focused. 
 

3.2.7.1.4 Contact:  Access critical customer data including key contacts, communication 
history, and more quickly and easily with WTM SalesGrow you’ll get a complete 
picture of every customer, from social insights to campaign history, to deals they're 
involved in. 
 

3.2.7.1.5 Account: Account management is the process of managing the communications 
and transactions with businesses having many contacts and divisions. This makes it 
possible to cater to the needs of specific divisions inside a business. By categorizing 
contacts to accounts by their subdivisions and functions, communication is directed 
to the proper personnel in charge. 
 
 
 

3.2.7.1.6 Potential: Get all the details on all your team’s deals — stage, products, 
competition, quotes, and more. See where leads come from and stay connected to 
the people and information you need to close every sale. 
 

3.2.7.1.7 Campaign: Campaign management allows you to plan, and keep track of the 

campaigns in your SalesGrow CRM account. 

 

 

 

3.2.7.1.8 Product: Products can be either goods or services, which are sold or procured by 

your organization. In SalesGrow CRM, you can manage your company- wide 

products that are sold to the customers as well as procured from vendors. Both 

sales and purchasing departments can use the Products module effectively 

according to their department process. If your organization procures products from 

vendors and then sells to customers with a markup, both the sales and purchasing 

departments can coordinate more effectively. 

Sales departments can use the products module along with other modules, such as 

leads, accounts, potentials, quotes, sales orders, and invoices. Purchasing 

departments can use the module along with Vendors and Purchase Orders. In 

general, the Product details page contains the product name, manufacturer or 

reseller name, part numbers, sales start and end dates, support start and end dates, 

price, stock position to name a few. 
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3.2.7.1.9 Purchase Order: A Purchase Order is an order placed for procuring products or 

services from your vendors. It is a legal binding document that protects interests of 

both the vendor and buyers. In general, a Purchase Order (PO) contains the PO 

number, date, line items (products) including the quantities and prices based on the 

Sales Quote, Billing address, Shipping address, and Terms & Conditions. You can use 

the PO for communicating your product and pricing requirements to vendors so 

there will not be any pricing questions in future. You can also use the PO to cross-

check the products shipped to your shipping address and invoices sent to you. In 

addition, your vendor can use the PO as a legal document in the event of 

nonpayment in a court of law.  

 

3.2.7.1.10   Sales Order:  The Sales Order is a confirmation document sent to the customers 

before delivering the goods or services. Sales Order (SO) can be created once the 

quote is accepted by your prospective customer (potential) and the Purchase Order 

(PO) is sent by the customer for further processing. After receiving the PO, the  

Customers may request SOs to know the exact date of delivery of the goods or 

services. Also the inventory/production department looks at the list of Sales Orders 

to see what needs to be shipped out and when. After the order is shipped and 

delivered to the customer an invoice is generated from the sales order for billing 

purposes. In general, SO contains the SO number, date, line items (products) 

including the quantities and prices based on the PO, Billing address, Shipping 

address, and the Terms & Conditions.  

 

3.2.7.1.11   Quote: Sales Quotes are legally binding agreements between a customer and 

vendor to deliver the customer requested products in a specified time-frame at a 

predefined price. Your customers can place orders within the stipulated period 

(validity date) that has been specified in the quote otherwise you may cancel the 

quote or send a new quote extending the time-frame. In general, a Sales Quote 

contains the Quote number, date, line items (products) including the quantities and 

prices based on your Price Books, Terms & Conditions. 

 

3.2.7.1.12   Vendor: Vendors include companies, people, and contractors from which your 

company gets products and services. They can be either direct manufacturers or 

resellers. 

  

3.2.7.1.13   Price Book: Price Books are used for selling products at different prices, based 
on the agreement terms with a particular type of customer. For each customer you 
can sell the same product at different prices. 

There are two key prices in price books. One is Unit Price and the other is                

List Price. 
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 Unit Price - It is a price fixed by the manufacturer for the product and 

which cannot be changed. 

 List Price - It is the sellers' price. The manufacturer/resellers may sell 

the product with different prices to their resellers/customers. These 

variable prices for the same product are called as List Prices. 
  

3.2.7.1.14   Invoice: Once the sales stage reaches its final phase you may start working on 

the payment procedure. In this regard an Invoice plays a vital role, which is 

important for both Sales and Accounting purposes. An invoice is a bill issued by the 

vendor to the customer along with the goods or services shipment. It usually 

contains the Purchase Order reference number, Date, Billing Address, Shipping 

Address, Terms of Payment, Line Items (products/services) with quantities and 

prices. In a typical organization, invoicing completes the sales process and begins 

the accounting process where accounts receivable is managed by the 

Accounts/Finance teams. 

 

 

 

3.2.7.1.15   Task: A task is a specific piece of work required to be done within a given time 

frame. They are listed in the SalesGrow CRM's Activities in other related records. 

 

3.2.7.1.16   Event: An event is an activity that happens at a given place and time. They are 

listed in the SalesGrow CRM's Home page of the user, Activities in other related 

records. 

 

3.2.7.1.17   Call: The Log Call functionality helps you to register the inbound calls (received 

from leads and customers) and outbound calls (dialed to leads and customers) with 

call details such as call duration, date and time of calls, notes, etc. 

 

3.2.7.1.18   Case: case trouble tickets are used to capture customer feedback on various types 

of issues that arise after purchasing a product or service from your company. 

Sometimes customers provide good feature requests using this platform that may 

be useful when developing future product or service enhancements. 

 

3.2.7.1.19   Solution: The Solutions module integrated with Cases is very useful for 

organizations that are mainly focusing on post-sales support, particularly technology 

and knowledge-based industries. 

3.2.7.1.20   Email:  The Email module manages your modules email history and provides 

functionally to compose email.  
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3.2.7.1.21   Report:  SalesGrow CRM reports are the detailed and informative list of records. 

Each report provides access to important data required for various purposes. 

Standard reports are provided in various modules, which can be either used as it is 

or customized further as per your business requirements. 

3.2.7.1.22   Forecast:  SalesGrow forecasts are an important measurement of your 

company's growth and success. Factors such as previous sales forecasts and 

revenue, competition, economic conditions, sales team and their performances, 

industry trends are considered while predicting monthly or quarterly sales targets. If 

your company meets consecutive sales forecasts, then you are assured that the 

company is growing! 

 

2.1.1.2 Module Tools  

 

3.2.7.1.23   Manage Home Components: You can customize the Home Component of 

your SalesGrow CRM account by adding what we call as components. Adding 

components to the Home tab is like creating a desktop shortcut to your favorite 

apps on your computer. It’s for quick and easy access to the things that you use the 

most. 

3.2.7.1.24   Manage Dashboard Components:  After creating a dashboard you must 

add components (representing the exact data in pictorial form), which includes Bar, 

Pie, Line, Funnel, or Table charts. You can select the charts to display the data in 

pictorial form and also a table to display the data in tabular format. 

 

3.2.7.1.25   Manage View:  In the <Module> Home page, you can select the required list 

view from the View drop-down list. You can only rearrange the order of the columns 

or add more columns to the standard view modes. 

You can create custom list views in SalesGrow CRM by defining criteria as per your 

requirement.  

 

3.2.7.1.26   Import Data:  Importing records help you to create new leads by gathering 

data through various sources, such as purchasing a record database, records from 

different business units, etc. You can import records with the help of two features: 

Import My [Module] - Use this feature to import the records owned by (assigned to) 

you. By default, the records' ownership is automatically assigned to the user who 

imports the records. 

Import My Organization [Module] - Use this feature to import all the records that 

are owned by (assigned to) the users in your organization, including the records 
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owned by you. While importing, the import file should have a column that contains 

the exact email address of the users to whom you want to assign each record. 

 

3.2.7.1.27   Export Data:  The Export Data feature allows you to export data (in CSV 

format) from individual CRM modules. After exporting the data, you can further 

validate or store the data in your own server(s). 

 

3.2.7.1.28   Mass Update: Update record value of the bulk records. 

 

 

3.2.7.1.29   Mass Transfer: Change the owner of the bulk records.  

 

3.2.7.1.30   Change Owner: Change the owner of the records. 

 

3.2.7.1.31   Mass Delete: Delete the data of the bulk records. 

 

3.2.7.1.32   Approve Records: The import feature and Web forms have an option to enable 

manual approval of records. When this option is enabled, records imported or 

gathered through web forms are not added directly to the modules. They need to 

be approved first for other users to access the records. Records can be approved for 

the Leads, Contacts, Cases or any other Custom module’s records. 

 

3.2.7.1.33   Manage Emails: With the SalesGrow Mail Add-on, now you can send 

Emails to your Leads, Contacts and Potentials modules. You need not go to your 

favorite Email service to communicate with your contacts. 

 

3.2.7.1.34   Manage Notes:  You can use the notes to write questions, reminders, and 

anything you would write on notepaper. These are useful for storing bits of 

information related to customers, which you may need later. 

3.2.7.1.35   Manage Activities: The Activities module is where you can create and 

associate business tasks, events and calls. Each activity has vital information on the 

date, time, priority level and notification parameters that can even be accessible 

from within the record it is associated to. 

 

3.2.7.1.36   Manage Attachments:  File attachments are documents, such as Marketing 

Collateral, Sales Quotes/Orders/Invoices, SLA, and others that can be associated to 

the CRM modules. 

 

3.2.7.1.37   Manage Related Modules: Each record in SalesGrow CRM has the option 

to associate other records to it. For example, a Contact has notes, activities, 
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potentials, products, attachments, etc. associated to it. These are called Related 

Lists and are provided by default but you can also have custom related list added to 

a record. Custom Related Lists helps you view data collected from other sources. 

 

3.2.7.1.38   Print Records: You can print record, invoice and all module view. 

 

 

 

 

    

 

2.1.2 Setup 

 

1.1.1.1 Organization Setting:  Before you get started, it is necessary that you add 

organizational details that include setting up currency, time zone, company 

logo, business hours, fiscal year, etc. These details will reflect in your 

organization's SalesGrow CRM account. 

 

1.1.1.1.1 Company Details: Personalize your company CRM account by 

setting your company details and company logo. Also, set your currency and define 

the fiscal year for your organization. 

 

1.1.1.1.2 Fiscal Year: The fiscal year setting helps organizations to configure 

their fiscal cycle based on the selected start month. Once the fiscal start month is 

selected, fiscal quarters are automatically rolled up. 

 

1.1.1.1.3 Business Hours: Customer support teams in an organization may 

follow their own business hours and work in shifts based on different time zones. 

1.1.1.2 Personal Setting: Users in many organizations work from different 

locations, across different time zones and geography. Each user can set up 

their personal preferences in SalesGrow.  You can personalize and manage the 

settings in your SalesGrow CRM account that includes defining a country 

locale, language, time zone, date format, etc. Certain operations that you 

perform in SalesGrow Accounts will be updated automatically in the personal 

settings of SalesGrow CRM and vice versa. 

 

1.1.1.2.1 Account Information: Personalize your CRM account by 

setting your country locale, time zone, language and personal details. 

 



   

13 
 

1.1.1.2.2 Name Format: By default, the name format is set as 

<Salutation> <First Name> <Last Name>. However, you can change the name 

format as per naming conventions used in your country. 

 

1.1.1.3 Themes: SalesGrow CRM Themes give individual users the option to 

customize the colors and layout of their CRM account 

 

1.1.1.4 Users and Permissions 

1.1.1.4.1 Users: User is one who manages records, their own or those shared by 

other users, within the organization. In addition to accessing the CRM data, some of 

the users can perform administrative functions for smooth running of the CRM 

account. 

 

 

1.1.1.4.2 Profiles: The profile function controls the permission to CRM 

modules, records, fields in a record, and various utilities, such as import, export, 

send email, mass update, etc. Users associated to the profile can access the 

functions that are assigned to them. 

 

1.1.1.4.3 Roles: You can set up the organization-wide hierarchy using 

Roles. Users at a higher hierarchy can always access all the records of at a lower 

hierarchy. 

 

1.1.1.4.4 Groups: You can create different types of groups (set of users) to 

manage a set of common records. Groups can be used for setting up team selling, 

team support, event management by a group of marketing users, etc. Users 

associated with a particular group can access the records shared to a particular 

group and perform the necessary operations on the records. 

 

 

1.1.1.4.5 Data Sharing Settings:  An Access right to SalesGrow records is 

set as private so that the record owner and his/her manager can oversee the CRM 

data. However, using the Data Sharing Rules, you can extend the access rights to 

users belonging to other roles and groups. Once the data sharing rules are 

configured, users associated to other roles and groups can gain additional access to 

the records that belong to other users. 
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1.1.1.5 Software Customization: Customizing is the most powerful way of 

achieving a successful organization-specific Customer Relationship 

Management system. One of the key elements of SalesGrow CRM is its capacity 

to allow customization and the flexibility to do so. 

1.1.1.5.1 Modules: You can add new modules as per your requirements. 

These modules will be available to all the users added to your organization's CRM 

account. 

 

1.1.1.5.2 Fields: You can add new fields as per your requirements. These 

fields will be available to all the users added to your organization's CRM account. 

 

1.1.1.5.3 Layouts: Page-Layout customization is one of the important 

functions that allow CRM administrators to define the organization-specific 

requirements within each module. Ideally, this should be completed before rolling 

out the CRM system for the organization. 

 

1.1.1.5.4 Search Layouts: The Search Layout helps you customize the field 

values that you want to view in search results. 

 

1.1.1.5.5 Related List: The Related Lists are the records that are associated to 

the parent record. 

 

1.1.1.5.6 Customer View Setting: You can set default view according to 

module. 

 

1.1.1.5.7 Related List Lookup:  The Related Lists Lookups are the records 

that are use for display that how many fields display in module lookup list. 

 

 

 

 

 

 

1.1.1.6 Templates 

1.1.1.6.1.1 Email Templates: Communicating with customers is an 

important activity in any business scenario. SalesGrow CRM provides Email 

Templates to send one message to multiple recipients. Email templates can be 

used to send a mass Email to leads/contacts, and send Email notifications to the 

SalesGrow CRM users upon triggering a workflow rule. 
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1.1.1.6.1.2 Inventory Templates: You can customize the Quote, 

Purchase Order, Sales Order and Invoice print layout as per your 

business requirements. As part of the template customization, 

you can change the fields in the print layout, position of the 

company logo, look & feel of the layout and alignment of the 

line items 

 

1.1.1.7 Automation:  SalesGrow CRM gives you the option to automate 

workflow procedures and set up automatic replies, alerts, and notifications in advance. 

2.1.2.6.1 Workflow: Workflow Tasks are assigned to the users when 

the associated workflow rules are triggered. A workflow task 

can be associated to a workflow rule, when you want to create 

a task and assign it to a user, upon triggering the rule. 

 

1.1.1.8 Data Administration 

2.1.2.7.1 Recycle Bin: The Recycle Bin stores all the records and files 

that are deleted from the SalesGrow CRM account. The records 

in the recycle bin will be available for 60 days after which it will 

be permanently deleted from your CRM account. 

 

1.1.1.9 Apps & Add-ons 

2.1.2.8.1 WTM Apps: The time and effort that you put into choosing 

and setting up a phone system for your business is always worth it. The goal 

is to give your customers an easy way to get in touch with you and provide 

the best services to clarify their doubts and address their concerns. Not to 

ignore the fact that, a good PBX system is of great help to the sales reps as 

well.  

1.1.1.10    Territory 

2.1.2.9.1 Territories: A territory is the demarcation of the sales force 

structure by which customers accounts are grouped and shared with the 

sales people of an organization. Territories can be based on various factors 

such as geography, industry, product line, the expected revenue, verticals, 

etc. 

When your business is spread across regions and you have multiple office 

divisions, departments and numerous products/services, it is not an easy 

task to assign customer accounts to sales teams without proper planning. In 

some cases, it is equally complex to provide access only to selective 

accounts, for individuals from different teams to work together for a 

common sales objective. 
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2.1.2.9.2 Territory Rules: Under Account Rule, specify criteria for 

accounts. Based on this rule criterion, territories will be assigned to 

accounts in SalesGrow CRM. 

Under Potential Rule, specify criteria for potentials. These options will be 

available only if it is enabled under Settings.  

Based on this rule criterion, territories will be assigned to potentials in 

SalesGrow CRM. 

 

2.1.2.9.3 Assign Territories:  When the territory's assignment rules 

are run, records that meet the rule criteria in the territory will automatically 

be assigned to the territory. Initially, when you go to Setup > Territory 

Management > Assign Territories in your SalesGrow CRM account, you 

need to run the rules for the existing accounts. Based on the account's 

territories, the associated contacts and potentials will also be assigned to 

territories. If you enable Potential Rules, you can run rules for potentials as 

well. 

 

 

 

 

2.1.3 Miscellaneous 

 

1.1.1.1 Manage Customize Reports: You can create new module-specific 

reports linking some of the other cross-functional modules. You can generate 

Tabular Report, Summary Report, and Matrix Report. 

 

1.1.1.2 Manage Scheduled Reports: You can automatically send reports to 

your colleagues, executive management and non-SalesGrow CRM users by 

scheduling the desired reports daily, weekly, monthly or yearly. Once the 

Report scheduler is configured, specified reports will be delivered to the 

recipients as an email attachment (XLS format). 

 

1.1.1.3 Manage Scheduled Emails: You can automatically send email 

according to scheduled time. 

 

1.1.1.4 Global Search: The search option helps locating specific information or 

specific records without having to go through the entire list of records, thus 

saving time in finding records. 
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1.1.1.5 Notification: Alert notification for unread task, event and any 

activities. 

 

 

3 Technical Requirements  

 

3.1 SaaS (Software as a Service) - WTM Cloud Host 

 

3.1.1 Performance 

             The information retrieval should be as fast as possible for customer satisfaction.  

To ensure this, the consumer should be able to download a page in 5 seconds 
with a 1024 Kbps modem. The form submission should not take a long time to be 
processed, especially in the CRM module case, in which form applications play a 
major role. 

Separation of connection handling and data processing 

Separation of connection handling and data processing would definitely improve 
the overall system performance as well as cost incurred. 

              

 

Software runs on an online platform 

 Slow data retrieval because of poor programming must be absolutely discarded 
since the software runs on an online platform.  

Minimize the data transfer time  

The size of data sent to the user can be limited to an upper bound, especially for 
the multimedia files, to minimize the data transfer time. 

Size of the secondary storage  

The larger the primary memory, the faster the applications would run. Moreover 
the size of the secondary storage should be sufficient for data swapping, 
recovery and backup procedures.  

 

3.1.2 Reliability & Availability 

Internet Service Provider 

The system shall provide a contractual agreement with an internet service 

provider for T3 access with 99.9999% availability. 
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 The system shall provide a contractual agreement with an internet service 

provider who can provide 99.999% availability through their network facilities 

onto the internet. 

Back-end Internal Computers 

The system shall provide storage of all databases on redundant computers with 
automatic switchover. 
 The system shall provide for replication of databases to off-site storage 
locations. 
 The system shall provide RAID V Disk Stripping on all database storage disks. 

  

3.1.3 Security 

The system shall automatically log out all customers after a period of inactivity. 

The system shall confirm all transactions with the customer’s web browser. 

The system shall not leave any cookies on the customer’s computer containing 

the user’s password. 

The system shall not leave any cookies on the customer’s computer containing 

any of the user’s confidential information.  

3.1.4 Supportability   

Compatible with Operating Systems 

 Any  Operating System 

3.1.5 Design Constraints 

Web Based Product 

The computers must be equipped with web browsers such as Firefox, Chrome.  

 The product must be stored in such a way that allows the client easy access to it.  

 Response time for loading the product should take no longer than five minutes.  

 A general knowledge of basic computer skills is required to use the product 

On-line User Documentation and Help System Requirements 

As the product is SalesGrow, On-line help system becomes a critical component 

of the system which shall provide – 

It shall provide specific guidelines to a user for using the SalesGrow system and 

within the system.  
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To implement online user help, link and search fields shall be provided.  

 

3.1.6 User Interfaces 

   The user interface for the software shall be compatible to any browser such as 
Mozilla Firefox or Google Chrome by which user can access to the system. 

 

3.1.7 Hardware Interfaces 

Since the application must run over the internet, all the hardware shall require 
to connect internet will be hardware interface for the system. As for e.g. 
Modem, WAN – LAN, Ethernet Cross-Cable. 

 

3.1.8 Communications Interfaces 

The system shall use the HTTP protocol for communication over the internet and 

for the intranet communication will be through TCP/IP protocol suite. 

 

 

3.2 Desktop - Self host by company 

 

3.2.1 Performance 

Separation of connection handling and data processing 

Separation of connection handling and data processing would definitely improve 
the overall system performance as well as cost incurred. 

             Software runs on an online platform 

 Slow data retrieval because of poor programming must be absolutely discarded 
since the software runs on an online platform.  

Minimize the data transfer time  

The size of data sent to the user can be limited to an upper bound, especially for 
the multimedia files, to minimize the data transfer time. 

 

3.2.2 Security 

The system shall automatically log out all customers after a period of inactivity. 

The system shall confirm all transactions with the customer’s web browser. 
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The system shall not leave any cookies on the customer’s computer containing 

the user’s password. 

The system shall not leave any cookies on the customer’s computer containing 

any of the user’s confidential information. 

3.2.3 Supportability   

Compatible with Operating Systems 

 Windows 

Compatible with J2EE Application Servers 

 Tomcat 

Compatible with Database 

 MySql 5.5 with JDBC driver 

                           Compatible with Java Virtual Machines 

 Sun JDK 1.7 with Windows NT, Solaris  and Red Hat Linux 

Compatible with System Requirements 

 1024 MB RAM or more 1000 MHz processor or better 

 

 1 GB disk space for application .war file 

 JDK 1.7 or higher 

 SQL database 

 

3.2.4 Design Constraints 

Web Based Product 

The computers must be equipped with web browsers such as Firefox, Chrome.  

 The product must be stored in such a way that allows the client easy access to it.  

 Response time for loading the product should take no longer than five minutes.  

 A general knowledge of basic computer skills is required to use the product 

 

3.2.5 User Interfaces 

   The user interface for the software shall be compatible to any browser such as 
Mozilla Firefox or Google Chrome by which user can access to the system. 



   

21 
 

 

3.2.6 Hardware Interfaces 

  No Internet need. If using multiple users, application must run over the LAN. 

3.2.7 Communications Interfaces 

The system shall use the HTTP protocol for communication over the internet and 

for the intranet communication will be through TCP/IP protocol suite. 
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                 http://wtmit.com/salesgrow 


